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Preface

About This Tutorial

The ISE 10.1 Quick Start Tutorial is a hands-on learning tool for new users of the ISE
software and for users who wish to refresh their knowledge of the software. The tutorial
demonstrates basic set-up and design methods available in the PC version of the ISE
software. By the end of the tutorial, you will have a greater understanding of how to
implement your own design flow using the ISE 10.1 software.

Additional Resources

To find additional documentation, see the Xilinx website at:

http:/ /www.xilinx.com/literature.

To search the Answer Database of silicon, software, and IP questions and answers, or to
create a technical support WebCase, see the Xilinx website at:

http:/ /www.xilinx.com/support.
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ISE 10.1 Quick Start Tutorial

The ISE 10.1 Quick Start Tutorial provides Xilinx PLD designers with a quick overview of
the basic design process using ISE 10.1. After you have completed the tutorial, you will
have an understanding of how to create, verify, and implement a design.

Note: This tutorial is designed for ISE 10.1 on Windows.

This tutorial contains the following sections:

“Getting Started”

“Create a New Project”

“Create an HDL Source”

“Design Simulation”

“Create Timing Constraints”

“Implement Design and Verify Constraints”
“Reimplement Design and Verify Pin Locations”

“Download Design to the Spartan™-3 Demo Board”

For an in-depth explanation of the ISE design tools, see the ISE In-Depth Tutorial on the
Xilinx® web site at: http:/ /www.xilinx.com/support/techsup /tutorials/

Getting Started

Software Requirements

To use this tutorial, you must install the following software:

ISE10.1

For more information about installing Xilinx® software, see the ISE Release Notes and

Installation Guide at: http:/ /www.xilinx.com /support/software_manuals.htm.

Hardware Requirements

To use this tutorial, you must have the following hardware:

Spartan-3 Startup Kit, containing the Spartan-3 Startup Kit Demo Board

ISE Quick Start Tutorial
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Starting the ISE Software
To start ISE, double-click the desktop icon,

or start ISE from the Start menu by selecting:

Start — All Programs — Xilinx ISE 10.1— Project Navigator

Note: Your start-up path is set during the installation process and may differ from the one above.

Accessing Help

At any time during the tutorial, you can access online help for additional information
about the ISE software and related tools.

To open Help, do either of the following:

Press F1 to view Help for the specific tool or function that you have selected or

highlighted.

Launch the ISE Help Contents from the Help menu. It contains information about

creating and maintaining your complete design flow in ISE.

ES Xilinx - ISE - C:\iMPACT Test\ISE\tutorialitutorial.ise

File Edit View Project Source Process Window JgEs)
FDPEHP i REX e
HENENERE R o

Help Topics

Software Manuals

¥ilinx on the Web 3
Tutorials 3
What's New in this release

Update Software Product Configuration. ..
Tip of the Day
¥ilinxUpdate. ..

About...

Figure 1:
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Create a New Project

Create a new ISE project which will target the FPGA device on the Spartan-3 Startup Kit
demo board.

To create a new project:

1. Select File > New Project... The New Project Wizard appears.

2. Type tutorial in the Project Name field.

3. Enter or browse to a location (directory path) for the new project. A tutorial
subdirectory is created automatically.

Verify that HDL is selected from the Top-Level Source Type list.

Click Next to move to the device properties page.

Fill in the properties in the table as shown below:

*

* & o

* & o

*

*

Product Category: All

Family: Spartan3

Device: XC3S200

Package: FT256

Speed Grade: -4

Top-Level Source Type: HDL

Synthesis Tool: XST (VHDL/Verilog)
Simulator: ISE Simulator (VHDL/Verilog)
Preferred Language: Verilog (or VHDL)

Verify that Enable Enhanced Design Summary is selected.

Leave the default values in the remaining fields.

When the table is complete, your project properties will look like the following:

EE New Project Wizard - Device Properties

=&

Selzct the Device and Design Flaw far the Praject

Property Mame Walue |
Product Categaory All w
Family Spartan3 w
Device #C35200 A4
Package FT25E w
Speed -4 v
Top-Level Source Tupe HOL
Synthesiz Tool HST WHDLAYerilog) -
Sirnulatar ISE Simulatar YHDLA erilog) -
Preferred Language Verilog -
Enable Enhanced Design Summary
Enable Mezsage Filtering Fl
Dizplay Incremental Meszages [l

[ [t ] [ o

Figure 2: Project Device Properties
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7. Click Next to proceed to the Create New Source window in the New Project Wizard. At
the end of the next section, your new project will be complete.

Create an HDL Source

In this section, you will create the top-level HDL file for your design. Determine the
language that you wish to use for the tutorial. Then, continue either to the “Creating a
VHDL Source” section below, or skip to the “Creating a Verilog Source” section.

Creating a VHDL Source

Create a VHDL source file for the project as follows:

1. Click the New Source button in the New Project Wizard.
2. Select VHDL Module as the source type.
3. Type in the file name counter.
4. Verify that the Add to project checkbox is selected.
5. Click Next.
6. Declare the ports for the counter design by filling in the port information as shown
below:
E= New Source Wizard - Define Module |Z||E|E|
Entity Mame |counter |
Architecture Mare |Behavinla| |
Fart Marme Direction Buz  MSBE LSB S
CLOCK in ~O
DIRECTION in ~O
COUNT_OUT out v 3 0
in v ]
in v ]
in v ]
in v ]
in v ] L
in v ]
in v ] 3
[ < Back l I Mext » ] [ Cancel l

Figure 3: Define Module

7. Click Next, then Finish in the New Source Wizard - Summary dialog box to complete
the new source file template.

8. (Click Next, then Next, then Finish.

The source file containing the entity/architecture pair displays in the Workspace, and the
counter displays in the Source tab, as shown below:
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S Xilinx - ISE - C:\iMPACT Test\ISEvtutorial\tutorial.ise - [counter.vhd]

File Edit View Project Source Process Window Help

NP EG LIADEX Do PPHARRA (A B MMM R ot I ERY
EZE BEUALHLIEE Z2 22 AR BN
13 —- Dependencies:
Sources for: | Implementation v 14 -
'-Fﬂtutnﬁal 15 —- Reviszion:
= £ xc3s200-4t 256 16 -- Revision 0.01 - File Created
ﬁ;coun’[er-Behavioml (counter vhd) i: -- Rdditional Comments:
13
20
21
22
E$ Sources |[|L~| Fles | s Snapshots |E Libraries 23
24
25 ——-- Uncomment the following library declaration if instantiating
Processes for; xc3s200-4ft 256 26 -—-- any ¥ilinx primitives in this code.
[ Add Bdsting Source 27 —-library UNISIM:
™ Create New Source 28 --use UNISIM.VComponents.all;
ﬁ Design Ltilties 2 . X
30 entity counter is
Sl Port ( CLOCE : in
32 DIRECTICH :
33 COUNT_OUT : > VECTCR (3 downto 0));
34 end counter;
3
36 architecture Behavioral of counter is
37
38 begin
33
40
41 end Behavicral:
42
AT

Figure 4: New Project in ISE

Using Language Templates (VHDL)

The next step in creating the new source is to add the behavioral description for the
counter. To do this you will use a simple counter code example from the ISE Language
Templates and customize it for the counter design.

1. Place the cursor just below the begin statement within the counter architecture.
2. Open the Language Templates by selecting Edit - Language Templates...

Note: You can tile the Language Templates and the counter file by selecting Window — Tile
Vertically to make them both visible.

3. Using the “+” symbol, browse to the following code example:

VHDL —> Synthesis Constructs —» Coding Examples — Counters — Binary —
Up/Down Counters — Simple Counter

4.  With Simple Counter selected, select Edit — Use in File, or select the Use Template in
File toolbar button. This step copies the template into the counter source file.

&
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5. Close the Language Templates.

Final Editing of the VHDL Source

1.

4.

Add the following signal declaration to handle the feedback of the counter output
below the architecture declaration and above the first begin statement:

signal count int : std logic vector (3 downto 0) := "0000";

Customize the source file for the counter design by replacing the port and signal name
placeholders with the actual ones as follows:

¢ replace all occurrences of <clock> with CLOCK

¢ replace all occurrences of <count _direction> with DIRECTION
¢ replace all occurrences of <count > with count_int

Add the following line below the end process; statement:

COUNT_OUT <= count_int;

Save the file by selecting File — Save.

When you are finished, the counter source file will look like the following:

library IEEE;

use IEEE.STD LOGIC 1164 .ALL;

use IEEE.STD LOGIC ARITH.ALL;
use IEEE.STD LOGIC UNSIGNED.ALL;

-- Uncomment the following library declaration if instantiating
-- any Xilinx primitive in this code.

--library UNISIM;

--use UNISIM.VComponents.all;

entity counter is
Port ( CLOCK : in STD LOGIC;
DIRECTION : in STD LOGIC;
COUNT OUT : out STD LOGIC VECTOR (3 downto 0));
end counter;

architecture Behavioral of counter is

signal count int : std logic vector (3 downto 0) := "0000";
begin

process (CLOCK)

begin

if CLOCK='1l' and CLOCK'event then
if DIRECTION='1l"' then
count_int <= count_int + 1;
else
count_int <= count_int - 1;
end if;
end if;
end process;
COUNT_OUT <= count_int;
end Behavioral;

12

www.xilinx.com ISE Quick Start Tutorial


http://www.xilinx.com

Create an HDL Source

SUXILINX®

You have now created the VHDL source for the tutorial project. Skip past the Verilog
sections below, and proceed to the “Checking the Syntax of the New Counter
Module”section.

Creating a Verilog Source

Create the top-level Verilog source file for the project as follows:

SANINLEE o e

Type in the file name counter.
Verify that the Add to Project checkbox is selected.
Click Next.

Declare the ports for the counter design by filling in the port information as shown
below:

E Mew Source Wizard - Define Module

Click New Source in the New Project dialog box.

Select Verilog Module as the source type in the New Source dialog box.

CE&

Module Name |counter

Fort Name Direction Buz  MSE LSE
CLOCK. input ]
DIRECTION inpLt v ]
COUNT_OuUT output v 1]
inpLt v ]
inpLt ~|
inpLt v ]
inpLt v ]
inpLt ~|
inpLt v ]
inpLt v ]
inpLt ~|
- —
[ < Back l I Mest > ] [ Cancel

Figure 5: Define Module

7. Click Next, then Finish in the New Source Information dialog box to complete the new
source file template.

8. (Click Next, then Next, then Finish.

ISE Quick Start Tutorial

www.xilinx.com

13


http://www.xilinx.com

SUXILINX®

The source file containing the counter module displays in the Workspace, and the counter
displays in the Sources tab, as shown below:

E= Xilinx - ISE - C:\iMPACT Test\ISE\tutorialitutorial.ise - [counter.v*]

File Edit View Project Source Process Window Help
DPEHI LIiKRDEX e RQiIPAXE PR (BB MDA M 6 [coum R
@@'l WMEPHAANIErE 252 43R OK
1 timescale ins / Ips A
Sources for: | Implementation 2 / |
=] tutorial 3
= £F xc3s200-47t 256 4 Engineer:
ﬁﬁﬂ counter (counter.v) S
a Create Date: 09:58:18 12/11/2007
7 /f Design Hame:
8 // Module Name: counter
9 // Project Name:
10 // Target Devices:
E@Soume||ﬁ| Files | g Snapshc| [ Librarie 11 // Tool versions:
e 12 / Description:
13/,
Processes for: xc3s200-4t256 14 // Dependencies:
[  Add Edsting Source s/
[ Create New Sounce 18 Rev%s%or_: B
«y Design Utilties 17 Re‘-.r'._.a'._or_ I_D.O'_ - File Created
18 / Additional Conmments:
i3
20
21 mod:,lle counter |
22 input CLOCK,
23 input DIRECTION,
24 cutput [3:0] COUNT_OUT
25 )i 1
26 |[ndmodule 3
< | >
E‘—t Processes | | — |
» ~
= v
7 (& | >
Ei [] Console | @6Ems | 1 Wamings | [ Tcl Shell || [ Find in Files
CAPS |NUM | SCRL |Ln 26 Col 1 | Verilog

Figure 6: New Project in ISE

Using Language Templates (Verilog)

The next step in creating the new source is to add the behavioral description for counter.
Use a simple counter code example from the ISE Language Templates and customize it for
the counter design.

1. Place the cursor on the line below the output [3:0] COUNT_OUT; statement.
2. Open the Language Templates by selecting Edit - Language Templates...

Note: You can tile the Language Templates and the counter file by selecting Window — Tile
Vertically to make them both visible.

3. Using the “+” symbol, browse to the following code example:

Verilog — Synthesis Constructs — Coding Examples — Counters — Binary —
Up/Down Counters — Simple Counter
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4. With Simple Counter selected, select Edit — Use in File, or select the Use Template in
File toolbar button. This step copies the template into the counter source file.

®

5. Close the Language Templates.

Final Editing of the Verilog Source

1. To declare and initialize the register that stores the counter value, modify the
declaration statement in the first line of the template as follows:
replace: reg [<upper>:0] <reg names;
with: reg [3:0] count int = 0;

2. Customize the template for the counter design by replacing the port and signal name
placeholders with the actual ones as follows:
¢ replace all occurrences of <clock> with CLOCK
¢ replace all occurrences of <up_down> with DIRECTION
¢ replace all occurrences of <reg _name> with count_int

3. Add the following line just above the endmodule statement to assign the register value
to the output port:

assign COUNT OUT = count int;
4. Save the file by selecting File — Save.
When you are finished, the code for the counter will look like the following;:

module counter (CLOCK, DIRECTION, COUNT_OUT) ;
input CLOCK;

input DIRECTION;

output [3:0] COUNT_OUT;

) ;

reg [3:0] count int = 0;
always @ (posedge CLOCK)
if (DIRECTION)
count int <= count int + 1;
else
count int <= count int - 1;

assign COUNT OUT = count int;
endmodule

You have now created the Verilog source for the tutorial project.

Checking the Syntax of the New Counter Module

When the source files are complete, check the syntax of the design to find errors and typos.

1. Verify that Implementation is selected from the drop-down list in the Sources
window.

2. Select the counter design source in the Sources window to display the related
processes in the Processes window.

ISE Quick Start Tutorial www.xilinx.com 15
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Click the “+” next to the Synthesize-XST process to expand the process group.
Double-click the Check Syntax process.

Note: You must correct any errors found in your source files. You can check for errors in the
Console tab of the Transcript window. If you continue without valid syntax, you will not be able to
simulate or synthesize your design.

Close the HDL file.

Design Simulation

Verifying Functionality using Behavioral Simulation

Create a test bench waveform containing input stimulus you can use to verify the
functionality of the counter module. The test bench waveform is a graphical view of a test
bench.

Create the test bench waveform as follows:

1.
2.
3.

Select the counter HDL file in the Sources window.
Create a new test bench source by selecting Project - New Source.

In the New Source Wizard, select Test Bench WaveForm as the source type, and type
counter_tbw in the File Name field.

Click Next.

The Associated Source page shows that you are associating the test bench waveform
with the source file counter. Click Next.

The Summary page shows that the source will be added to the project, and it displays
the source directory, type, and name. Click Finish.

You need to set the clock frequency, setup time and output delay times in the Initialize
Timing dialog box before the test bench waveform editing window opens.

The requirements for this design are the following;:

¢ The counter must operate correctly with an input clock frequency = 25 MHz.

¢ The DIRECTION input will be valid 10 ns before the rising edge of CLOCK.

¢ The output (COUNT_OUT) must be valid 10 ns after the rising edge of CLOCK.
The design requirements correspond with the values below.

Fill in the fields in the Initialize Timing dialog box with the following information:

¢ Clock High Time: 20 ns.

¢ Clock Low Time: 20 ns.

¢ Input Setup Time: 10 ns.

¢ Output Valid Delay: 10 ns.
¢ Offset: 0 ns.

¢ Global Signals: GSR (FPGA)
Note: When GSR(FPGA) is enabled, 100 ns. is added to the Offset value automatically.
¢ Initial Length of Test Bench: 1500 ns.

16
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Leave the default values in the remaining fields.

E= Initial Timing and Clock Wizard - Initialize Timing

MWlasimum
autpLt delay‘;

_ Clock —— Clock -

Minimum
m INPLE

Clock: Timing Information

outputs are checked at "Output Valid Delay™.
{*) Rising Edge () Falling Edge
(" Dual Edge (DDR or DET)
Clock High Time ns
Clock Low Time ns
Input Setup Time ns
Output Valid Delay ns
e —

Global Signals
PRLD {CPLD) GSR (FPGA)

High for Intial: |1I}D | ns

high far |y far
Clock Information
Inputs are assigned at "Input Setup Time" and (%) Single Clock | CLOCK s

() Muttiple Clocks

(") Combinatorial for intemal clock)

Combinatorial Timing Information

Inputs are assigned, outputs are decoded then
checked. A delay between inputs and outputs avoids
assignment./checking conflicts.

Check Outputs El ns After Inputs are Assigned
Assign Inputs El ns After Outputs are Checked

Initizl Length of Test Bench: | 1500| ns
Time Scale: | ns A

[] Add Asynchronous Signal Suppart

< Back I Finizh ] [ Cancel

)

Figure 7:

Initialize Timing

Click Finish to complete the timing initialization.

The blue shaded areas that precede the rising edge of the CLOCK correspond to the
Input Setup Time in the Initialize Timing dialog box. Toggle the DIRECTION port to
define the input stimulus for the counter design as follows:

¢ Click on the blue cell at approximately the 300 ns to assert DIRECTION high so
that the counter will count up.

¢ Click on the blue cell at approximately the 900 ns to assert DIRECTION low so
that the counter will count down.

ISE Quick Start Tutorial www.xilinx.com
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Note: For more accurate alignment, you can use the Zoom In and Zoom Out toolbar buttons.

End Time:
1500 ns

all cLock

M DIRECTION

Jh COUNT_OU...

14250 ng

C QU i i U i i v T e

0
410 ( 4hi

Figure 8: Test Bench Waveform

10. Save the waveform.

11. In the Sources window, select the Behavioral Simulation view to see that the test
bench waveform file is automatically added to your project.

Sources for: | Implementation
'-E']tmoﬁ Implementation
= £ xc3e] Behavioral Simulation

Figure 9: Behavior Simulation Selection

12. Close the test bench waveform.

Simulating Design Functionality

Verify that the counter design functions as you expect by performing behavior simulation
as follows:

1. Verify that Behavioral Simulation and counter_tbw are selected in the Sources
window.

2. Inthe Processes tab, click the “+” to expand the Xilinx ISE Simulator process and
double-click the Simulate Behavioral Model process.

The ISE Simulator opens and runs the simulation to the end of the test bench.

3. To view your simulation results, select the Simulation tab and zoom in on the
transitions.

18
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Current Simulation
Time: 1000 ns

The simulation waveform results will look like the following:

0 ns 100 ns 200 ns 300 ns 400 ns 500 ns 600 ns 700 ns 800 ns 900 ns 1000 ns
o b b b b b b b b b

Figure 10: Simulation Results

Note: You can ignore any rows that start with TX.
Verify that the counter is counting up and down as expected.

5. Close the simulation view. If you are prompted with the following message, “You have
an active simulation open. Are you sure you want to close it?”, click Yes to continue.

You have now completed simulation of your design using the ISE Simulator.

Create Timing Constraints

Specify the timing between the FPGA and its surrounding logic as well as the frequency
the design must operate at internal to the FPGA. The timing is specified by entering
constraints that guide the placement and routing of the design. It is recommended that you
enter global constraints. The clock period constraint specifies the clock frequency at which
your design must operate inside the FPGA. The offset constraints specify when to expect
valid data at the FPGA inputs and when valid data will be available at the FPGA outputs.

ISE Quick Start Tutorial
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Entering Timing Constraints

To constrain the design do the following:

1.
2.
3.

4.

EPro ject Navigator &|

Select Implementation from the drop-down list in the Sources window.
Select the counter HDL source file.

Click the “+” sign next to the User Constraints processes group, and double-click the
Create Timing Constraints process.

ISE runs the Synthesis and Translate steps and automatically creates a User
Constraints File (UCF). You will be prompted with the following message:

P This process requires that an Implementation Constraint File {UCF) be added
\.1) ko the project and associated with the selected design module, Wiould wou like
Project Mavigator ko automatically create a UCF and add it to the project at
this time?
IF ywou select "Mo" wou will need to create or add an exisking UCF ko the project
before running this process,

e J w ]

Figure 11: Prompt to Add UCF File to Project

Click Yes to add the UCF file to your project.

The counter.ucf file is added to your project and is visible in the Sources window.
The Xilinx Constraints Editor opens automatically.

Note: You can also create a UCF file for your project by selecting Project — Create New
Source.

In the Timing Constraints dialog, enter the following in the Period, Pad to Setup, and
CLock to Pad fields:

¢ Period: 40
¢ Pade to Setup: 10
¢ Clock to Pad: 10

6. Press Enter.

20
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7. Select Timing Constraints under Constraint Type in the Timing Constraints tab and
the newly created timing constraints are displayed as follows:

Constraint Files

After the information has been entered, the dialog should look like what is shown

below..

Constraint Files
[ counterucf v

O Show Constraints from Specified File only
@ Show Constraints from Al Files

Constraint Type
= Timing Constraints
Global

Ports
" 4

(O

&3 Sourc ”@ Files ”w Sna[”l@ Librari (G5} Timing Cc|

==
Processes for: counter - Behavioral )
[  Add Edsting Source
[ Create New Source
£ View Design Summary
Design Ltilties
User Constraints
8 Creste Timinn Conatraints

A Processes |

[£3

[ES Xilinx - ISE - C:\iMPACT Test\ISE\tutorial\tutorial.ise - [Timing Constraints*]

i File Edit Wiew Project Source Process Window Help
DAEHS LidpRX 2 QiPLPHAEPR [AimE O AN 0 Ecm ¥ ¢
EFE UL OO i

Clock Net Name
CLOCK

<

Period
40 ns. HIGH 50%

Padto Setup

Clock to Pad
10ns

¥ Design Summary ‘ "ﬁmmg Constraints™; ‘

<

5 (&3 |
5] Console | @ Emon | gy wamings | @@Teisnet | fgg Findin Fies |

|

Figure 12: Creating Timing Constraints

linx - ISE - C:\iMPACT Test\ISE\tutorial\tutorial.ise - [Timing Constraints*]
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Figure 13: Timing Constraints
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8. Save the timing constraints. If you are prompted to rerun the TRANSLATE or XST
step, click OK to continue.

9. Close the Constraints Editor.

Implement Design and Verify Constraints

Implement the design and verify that it meets the timing constraints specified in the
previous section.

Implementing the Design

1. Select the counter source file in the Sources window.

2. Open the Design Summary by double-clicking the View Design Summary process in
the Processes tab.

3. Double-click the Implement Design process in the Processes tab.

Notice that after Implementation is complete, the Implementation processes have a
green check mark next to them indicating that they completed successfully without
Errors or Warnings.

S Xilinx - ISE - C:\iMPACT Test\ISE\tutorial\tutorial.ise - [Design Summary]
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Figure 14: Post Implementation Design Summary

5. Locate the Performance Summary table near the bottom of the Design Summary.
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6. Click the All Constraints Met link in the Timing Constraints field to view the Timing
Constraints report. Verify that the design meets the specified timing requirements.

E Design Summary
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Clock Repart
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Figure 15: All Constraints Met Report

7. Close the Design Summary.

Assigning Pin Location Constraints

Specify the pin locations for the ports of the design so that they are connected correctly on
the Spartan-3 Startup Kit demo board.

To constrain the design ports to package pins, do the following;:

1. Verify that counter is selected in the Sources window.

2. Double-click the Floorplan Area/lO/Logic - Post Synthesis process found in the
User Constraints process group. The Xilinx Pinout and Area Constraints Editor
(PACE) opens.

3. Select the Package View tab.

In the Design Object List window, enter a pin location for each pin in the Loc column
using the following information:

¢ CLOCK input port connects to FPGA pin T9 (GCKO signal on board)

¢ COUNT_OUT<0> output port connects to FPGA pin K12 (LDO signal on board)
¢ COUNT_OUT<1> output port connects to FPGA pin P14 (LD1 signal on board)
¢ COUNT_OUT<2> output port connects to FPGA pin L12 (LD2 signal on board)
¢ COUNT_OUT<3> output port connects to FPGA pin N14 (LD3 signal on board)
¢ DIRECTION input port connects to FPGA pin K13 (SW7 signal on board)
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Notice that the assigned pin locations are shown in blue:
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Figure 16: Package Pin Locations

5. Select File — Save. You are prompted to select the bus delimiter type based on the
synthesis tool you are using. Select XST Default <> and click OK.

6. Close PACE.

Notice that the Implement Design processes have an orange question mark next to them,
indicating they are out-of-date with one or more of the design files. This is because the UCF

file has been modified.

Reimplement Design and Verify Pin Locations

Reimplement the design and verify that the ports of the counter design are routed to the
package pins specified in the previous section.

First, review the Pinout Report from the previous implementation by doing the following:

1. Open the Design Summary by double-clicking the View Design Summary process in

the Processes window.
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2. Select the Pinout Report and select the Signal Name column header to sort the signal
names. Notice the Pin Numbers assigned to the design ports in the absence of location
constraints.

File View Window Help
QOB M™
& FPGA Design Summary | | Fin Signal Fin Fin Direction 10 10 Bank | Drive  Slew T
@Design Dvervisw Mumber = Mame Usage  Mame Standard Mumber | [m&]  FRate
Summary BE CLOCK IOB  10_L32N_0/GCLE? INPUT  LYCMOS25 0
) I0B Properties R7 COUNT_OUT<0> IDE  10_L31P_5/D5 OUTPUT | LYCMOS25 5 1250w NONE
ol
[] Timing Canstraints M7 COUNT_OUT<T> I0E | 10_L30P_5 OUTPUT | LYCMOS25 5 1250w NONE
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Figure 17: Package Pin Locations Prior to Pin Location Constraints

3. Reimplement the design by double-clicking the Implement Design process.

Select the Pinout Report again and select the Signal Name column header to sort the
signal names.

5. Verify that signals are now being routed to the correct package pins.

File View Window Help
QDR M
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Figure 18: Package Pin Locations After Pin Location Constraints

6. Close the Design Summary.

Download Design to the Spartan™-3 Demo Board

This is the last step in the design verification process. This section provides simple
instructions for downloading the counter design to the Spartan-3 Starter Kit demo board.

1. Connect the 5V DC power cable to the power input on the demo board (J4).
2. Connect the download cable between the PC and demo board (J7).
3. Select Implementation from the drop-down list in the Sources window.
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4. Select counter in the Sources window.
5. In the Process window, double-click the Configure Target Device process.
6. The Xilinx WebTalk Dialog box may open during this process. Click Decline.

iMPACT opens and the Configure Devices dialog box is displayed.

1 iMPACT - Welcome to iMPACT Al=ll.3

Fleasze select an action from the list below

(*) Configure devices using Boundary-Scan [JTAG)
Automatically connect bo a cable and identify Boundary-Scan chain -
(") Prepare a PROM File
(") Prepare a System ACE File
() Prepare a Baundary-Scan File
SwF
(") Configure devices

uzing Slave Serial mode

<Back | Fiish | [ Cancel l

Figure 19: iIMPACT Welcome Dialog Box

In the Welcome dialog box, select Configure devices using Boundary-Scan (JTAG).

Verify that Automatically connect to a cable and identify Boundary-Scan chain is
selected.

9. Click Finish.
10. If you get a message saying that there are two devices found, click OK to continue.

The devices connected to the JTAG chain on the board will be detected and displayed
in the iMPACT window.
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11. The Assign New Configuration File dialog box appears. To assign a configuration file
to the xc3s200 device in the JTAG chain, select the counter .bit file and click Open.
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[E]PROM File Foimatter - fle 7 - - file 7 -

= Assign New Configuration, File
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] gl >nap D e ——— o. Cisim ) templates
Processes x D_ngo Dhismimp_save [)ust
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Transcript x Cancel Al ] ’ Bypass ]
/¢ *** BATCH CHMD : setMode -hs ~ @ MNare
/4 *%+ BATCH CHMD : setMode -hs =
GUI --- Auto connect to cable... () Enable Programming of SPI Flash Device Attached to this FPGA
T . -
o BATCH CHD : setCabls -port auto e () Enable Programming of BPI Flash Device Attached to this FPGA
3 | ¥

Corsole |° Emors |t Wamings | & Tel Shell | [ag Find in Files

i Desian Summary (f@ Baoundary Scan

Configuration | Parallel I | 200 KHz | LPT1

Figure 20: Assign New Configuration File

12. If you get a Warning message, click OK.
13. Select Bypass to skip any remaining devices.

14. Right-click on the xc3s200 device image, and select Program... The Programming
Properties dialog box opens.

15. Click OK to program the device.

When programming is complete, the Program Succeeded message is displayed.

Program Succeeded

On the board, LEDs 0, 1, 2, and 3 are lit, indicating that the counter is running.
16. Close iMPACT without saving.

You have completed the ISE Quick Start Tutorial. For an in-depth explanation of the ISE
design tools, see the ISE In-Depth Tutorial on the Xilinx® web site at:
http:/ /www.xilinx.com/support/techsup/tutorials/
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